System 800xA
PLC Connect
Operation
System Version 5.1
NOTICE

This document contains information about one or more ABB products and may include a description of or a reference to one or more standards that may be generally relevant to the ABB products. The presence of any such description of a standard or reference to a standard is not a representation that all of the ABB products referenced in this document support all of the features of the described or referenced standard. In order to determine the specific features supported by a particular ABB product, the reader should consult the product specifications for the particular ABB product.

ABB may have one or more patents or pending patent applications protecting the intellectual property in the ABB products described in this document.

The information in this document is subject to change without notice and should not be construed as a commitment by ABB. ABB assumes no responsibility for any errors that may appear in this document.

In no event shall ABB be liable for direct, indirect, special, incidental or consequential damages of any nature or kind arising from the use of this document, nor shall ABB be liable for incidental or consequential damages arising from use of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written permission from ABB, and the contents thereof must not be imparted to a third party nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license and may be used, copied, or disclosed only in accordance with the terms of such license. This product meets the requirements specified in EMC Directive 2004/108/EEC and in Low Voltage Directive 2006/95/EEC.

TRADEMARKS

All rights to copyrights, registered trademarks, and trademarks reside with their respective owners.

Copyright © 2003-2010 by ABB.
All rights reserved.

Release: June 2010
Document number: 3BSE035040-510
# TABLE OF CONTENTS

## About This Book
- General .............................................................................................................................. 7
- Document Conventions ..................................................................................................... 7
- Warning, Caution, Information, and Tip Icons ................................................................. 7
- Terminology ....................................................................................................................... 8
- Related Documentation ..................................................................................................... 8

## Section 1 - Introduction
- Welcome to PLC Connect ................................................................................................. 9
  - Release Information ....................................................................................................... 9

## Section 2 - Process Graphics
- Introduction .................................................................................................................... 11
- Warning Levels ............................................................................................................... 11
- Configuration of PLC Connect Graphic Elements .......................................................... 12
  - Creating Graphic Element Aspects ............................................................................. 12
  - Editing a Graphic Element in Graphics Builder ....................................................... 13
  - Creating a Tank Element ......................................................................................... 17
  - Creating a Valve Element ....................................................................................... 20
- Adding PLC Connect Graphic Elements to Graphic Displays ....................................... 22
- Faceplate ....................................................................................................................... 24
  - User Interface ........................................................................................................... 25
- Configuring the Faceplate ............................................................................................ 28
  - Layout Tab .................................................................................................................. 30
  - Header Tab ................................................................................................................ 31
  - Indicators Tab ............................................................................................................ 33
About This Book

General

This manual describes how to operate PLC Connect functions.

Document Conventions

Microsoft Windows conventions are normally used for the standard presentation of material when entering text, key sequences, prompts, messages, menu items, screen elements, and so on.

Warning, Caution, Information, and Tip Icons

This publication includes Warning, Caution, and Information where appropriate to point out safety related or other important information. It also includes Tip to point out useful hints to the reader. The corresponding symbols should be interpreted as follows:

- Electrical warning icon indicates the presence of a hazard which could result in electrical shock.
- Warning icon indicates the presence of a hazard which could result in personal injury.
- Caution icon indicates important information or warning related to the concept discussed in the text. It might indicate the presence of a hazard which could result in corruption of software or damage to equipment/property.
Although Warning hazards are related to personal injury, and Caution hazards are associated with equipment or property damage, it should be understood that operation of damaged equipment could, under certain operational conditions, result in degraded process performance leading to personal injury or death. Therefore, fully comply with all Warning and Caution notices.

### Terminology

A complete and comprehensive list of Terms is included in the IndustrialIT Extended Automation System 800xA, Engineering Concepts instruction (3BDS100972*). The listing included in Engineering Concepts includes terms and definitions as they that apply to the 800xA system where the usage is different from commonly accepted industry standard definitions and definitions given in standard dictionaries such as Webster’s Dictionary of Computer Terms.

### Related Documentation

A complete list of all documents applicable to the 800xA IndustrialIT Extended Automation System is provided in Released User Documents (3BUA000263*). This document lists applicable Release Notes and User Instructions. It is provided in PDF format and is included on the Release Notes/Documentation media provided with your system. Released User Documents are updated with each release and a new file is provided that contains all user documents applicable for that release with their applicable document number. Whenever a reference to a specific instruction is made, the instruction number is included in the reference.
Section 1  Introduction

Welcome to PLC Connect

PLC Connect is a connectivity option to Industrial IT 800xA that makes it possible to connect and integrate any type of remote or local installed PLC, RTU or other type of device. The information from the connected unit can be treated in the same way as information from other 800xA System connectivities.

Release Information

Read the Release Notes for information concerning the specific release of PLC Connect.
Section 2  Process Graphics

Introduction

Process graphics are used to show a representation of a process, including current states, such as whether a pump is on or off, and process values, such as the temperature in a tank. Via the graphics, it is possible to interact with and control the actual process; for example, open or close a valve.

Warning Levels

The warning levels are shown in Table 1:

If there is more than one warning for a signal, the top priority warning level will be displayed. The same is valid when a summarized warning level is shown for the signals in a process object.

Table 1. Warning Levels

<table>
<thead>
<tr>
<th>Priority</th>
<th>Appearance</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (Top)</td>
<td>![Communication error icon]</td>
<td>Communication error, that is, communication is down between PLC Connect and a connected PLC or OPC server.</td>
</tr>
<tr>
<td>2</td>
<td>![Warning icon]</td>
<td>The signal status of the value is uncertain. The reason can be, for example: • Value has not yet been updated from its source. • Value has moved outside its configured range.</td>
</tr>
</tbody>
</table>
Table 1. Warning Levels (Continued)

<table>
<thead>
<tr>
<th>Priority</th>
<th>Appearance</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>[image]</td>
<td>The signal is control disabled.</td>
</tr>
<tr>
<td>4 (Lowest)</td>
<td>[image]</td>
<td>The signal value is forced, that is, it is locked locally in PLC Connect.</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>No warning exists. (Invisible)</td>
</tr>
</tbody>
</table>

Configuration of PLC Connect Graphic Elements

This section includes a few examples to illustrate the usage of different PLC Connect Graphic Elements and Controls.

Creating Graphic Element Aspects

1. Select an object type in the Object Type Structure. See Figure 1.
2. Right-click and select New Aspect from the context menu.
3. Select Graphic Element PG2 aspect category.
4. Enter a name for the graphic element and click Create.
Editing a Graphic Element in Graphics Builder

Execute the following steps to add a symbol factory symbol to the graphic aspect.

1. In the **Object Type Structure**, select the *SimpleOnOffMotor* object.
2. Select the newly created graphic element *LorryElement* as shown in **Creating Graphic Element Aspects**.
3. Right-click this aspect and select **Edit** from the context menu. This opens the Graphics Builder.
4. Drag and drop the **Symbol Factory Symbol** (Toolboxes > Special) into the edit panel of the Graphics Builder.
5. Right-click the symbol and select **Edit** from the context menu. See **Figure 2**.
This displays the **Symbol factory properties** dialog as shown in Figure 3.
6. Select the required symbol. Click **Apply** and then click **OK** to save the changes.

7. In the **Properties** window of this symbol, click corresponding to the **Visible** property to open the **Expression Editor**.

8. Write the following expression to connect the **Visible** property to the binary process signal. This expression is used to display the symbol only if the signal value is **True**.
if Motor_ON:Value then
    True
else
    False

For more information on using the Expression Editor, refer to IndustrialIT 800xA, Engineering, Process Graphics User Guide (3BSE049230*).

9. Click OK to save the expression.

Adding the Error Indicator

The ErrorIndicator is used to indicate the quality of subscribed data, when it reaches the limits defined by the OPC. If the ErrorIndicator has any property configured to a dynamic expression value, the runtime mode displays the actual representation. The DataQuality property of the ErrorIndicator controls the quality of subscribed data.

Drag and drop the Error Indicator (Toolboxes > Graphic Primitives) into the edit panel of the Graphics Builder.

Figure 4. Adding an Error Indicator to the graphic element
10. Write the following expression to connect the **DataQuality** property to the binary process signal. This expression is used to display the data quality based on the signal value.

   ```
   if Motor_ON:LowLimit < 10 then
       Bad
   else
       Good
   ```

   For more information on using the Expression Editor, refer to *IndustrialIT 800xA, Engineering, Process Graphics User Guide* (3BSE049230*).

11. Click **OK** to save the expression.

**Creating a Tank Element**

The primitives required for building a tank are available in **Toolboxes > Shapes**. This includes the following primitives:

- **TankBody** - This is used as the body of tank object.
- **TankBottom** - This is used as the bottom of tank object.
- **TankCone** - This is used as the top of tank object.
- **TankNeck** - This is used as the bottom of tank object.
- **TankTop** - This is used as the top of tank object.

Execute the following steps to create a tank element.

1. Open the Graphics Builder. For more information on editing a graphic aspect, refer to *Editing a Graphic Element in Graphics Builder* on page 13.
2. Drag and drop **Tank Body**, **Tank Top**, and **Tank Bottom** primitives (**Toolbox > Shapes**) into the edit panel.
3. Move and resize the primitives as shown in Figure 5.
4. Press SHIFT and click **Tank Body**, **Tank Top**, and **Tank Bottom** to select the primitives.
5. Select **Format > Group** to group the primitives.
Use the handles as shown in Figure 6 to resize the tank elements if required. In the Properties window, the user can also modify the Height and Width properties to resize the shapes.

Figure 5. PLC Subelements Tank Element
Adding a Bar to Tank Element

Drag and drop Bar (Toolboxes > Graphic Primitives) into the edit panel of the Graphics Builder.

Place the primitive within the tank element as shown in Figure 7.

---

Figure 6. Resizing the tank elements

Figure 7. Bar Graph added to Tank Element
Receiving live data to the Tank Element

1. Select the Bar primitive.
2. In the Properties window, click corresponding to the BarValue property. This opens the Expression Editor.
3. Write the following expression.

   \[ \text{Motor\_ON:HighLimit} \]

   The value of the bar will be based on the value of \text{HighLimit} property of the signal.

Creating a Valve Element

1. In the Object Type Structure, select a Valve object type from Plant\&Mill > Valves.
2. Right-click the object type and select New Aspect from the context menu.
3. Select AlarmStatus aspect category.
4. Click Create. The AlarmStatus aspect is required to propagate the alarm information to the object type.

   Do not rename the AlarmStatus aspect.

5. Right-click this object type and select New Aspect.
7. Enter a name for the graphic element (For example, Valve Element) and click Create.
8. Right-click the element and select Edit from the context menu. This opens the Graphics Builder.
9. Drag and drop the Valve primitive (Toolboxes > Standard Symbols) and Alarm Symbol primitive (Toolboxes > Graphic Primitives) into the edit panel of the Graphics Builder.
10. Drag and drop the Reduced Icon primitive (Toolboxes > Standard Symbols) into the edit panel of the Graphics Builder.

11. In the Properties window, set the OpNote property to True to display the operator message.

12. Select the Valve primitive.

13. In the Properties window, set the CfgOrientation to Vertical or Horizontal to set the direction of the valve.

14. In the Properties window, click corresponding to the Open property. This opens the Expression Editor.

Figure 8. Creating a Valve Element
15. Write the following expression to connect the **Open** property to the binary process signal. This expression is used to control the opening and closing of this valve.

   ```
   if Motor_ON:HighLimit > 50 then 
       True
   else
       False
   ```

16. Click **OK** to save the expression.

17. Select the **AlarmControl** primitive.

18. In the **Properties** window, click corresponding to the **AlarmState** property. This opens the Expression Editor.

19. Write the following expression to connect the **AlarmState** property to the **AlarmStatus** aspect of the object type.

   ```
   SimpleOnOffMotor:AlarmState
   ```

20. Click **OK** to save the expression.

21. Select **File > Save** to save the graphic aspect.

   Execute the above procedure to configure a motor (**Toolboxes > Classic Symbols**), a three way valve (**Toolboxes > Classic Symbols**) or any other symbol required.

---

**Adding PLC Connect Graphic Elements to Graphic Displays**

1. In the **Functional Structure**, right-click an object and select **New Aspect** from the context menu.

2. Select the **Graphic Display PG2** aspect category.

3. Enter a name for the graphic display (For example, Delivery Overview) and click **Create**.
4. Right-click the graphic display and select **Edit** from the context menu. This opens the Graphics Builder.

5. Select **View > Element Explorer** to open the element explorer.

6. Browse to the required object type and select the PLC Connect Process Object.

7. Double-click the element to add it to the edit panel of the Graphics Builder. See Figure 9.

8. Select **File > Save** to save the graphic aspect.

*Figure 9. Inserting PLC Connect Element in Graphic Display*
Faceplate

Faceplates are used for monitoring and controlling the process. They are invoked by:

- left-clicking on a graphic element placed on a graphic display. See Figure 10.
- selecting Faceplate aspect in the Plant Explorer workplace, right-clicking it and selecting one of the required faceplate view from the context menu. See Figure 11.

Figure 10. Graphic Display
User Interface

Faceplate appears as shown in the following Figure 12.

Figure 12. Faceplate view
The visible components of the faceplate interface can be broadly classified into three areas (See Figure 12). These are:

- Header Area
- Element Area
- Button Area

Each of these areas contain several operable elements that configure, modify or display aspects of the faceplate.

For more information on Faceplate see *IndustrialIT 800xA, Engineering, Process Graphics User Guide (3BSE049230-510)*

**Header Area**

The Header area comprises of:

- Object lock
- Object description
- Alarm control

**Object lock**

Object Locking is used in environments where several operator workplaces control the same objects. Only one operator can use the Object Lock function to operate the objects. The Lock Control button is optional. The faceplate framework reserves space for it in the header area.

It provides the option to control the function manually or automatically. If Autolock is enabled, the object will be locked after the user opens the faceplate. When the faceplate is closed, the Lock Status will revert to unlocked.

If the Object Lock function is controlled manually, the user locks an object by clicking the **Object Lock** push button (refer Figure 12). If the lock required option is enabled, all buttons and commands will be disabled till the user clicks the Object Lock button.

To switch between Autolock and manual lock, change the *FaceplateAutoLockObject* profile value in the *Graphics Profile Values user profile*.

If the object is locked by another operator, operation is not possible until the lock is released. To release an object lock, the operator owning the lock can manually
unlock it, or the operator can close the faceplate. The object lock may time out after a default time of four minutes. A privileged user can also break the object lock through the context menu of Lock Control.

**Object Name and Description**

This displays the name and description of the object, for example, LI330 - Level Tank 1 (See Figure 12). Object name and object description is optional because of user profile setting.

**Alarm Control**

The Alarm Control button indicates the alarm state of the object, and allows acknowledgement of alarms. The alarm control is a graphic element aspect. Alarm Control details are displayed in the header area of the faceplate. Alarm button configuration is done using the AlarmControl aspect.

Table 2 shows the most common alarm indicators.

*Table 2. Alarm Indicators*

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Alarm Icon" /></td>
<td>Alarm is active and acknowledged.</td>
</tr>
<tr>
<td><img src="image2" alt="Alarm Icon" /></td>
<td>Alarm is active, but not acknowledged.</td>
</tr>
<tr>
<td><img src="image3" alt="Alarm Icon" /></td>
<td>Indicates illegal alarm configuration.</td>
</tr>
<tr>
<td><img src="image4" alt="Alarm Icon" /></td>
<td>Alarm is automatically disabled by the system.</td>
</tr>
<tr>
<td><img src="image5" alt="Alarm Icon" /></td>
<td>Alarm disabled by a user.</td>
</tr>
</tbody>
</table>
### Table 2. Alarm Indicators (Continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Alarm Symbol" /></td>
<td>Alarm is idle, that is there are no alarms.</td>
</tr>
<tr>
<td><img src="image" alt="Alarm Symbol" /></td>
<td>Alarm is neither active, nor acknowledged.</td>
</tr>
<tr>
<td><img src="image" alt="Hidden Alarm" /></td>
<td>Hidden Alarm. A white rectangle covering an alarm symbol, shows that there are hidden alarms for the object.</td>
</tr>
<tr>
<td><img src="image" alt="Shelved Alarm" /></td>
<td>Shelved Alarm. A white circle appearing to the right of the alarm symbol shows that there are shelved alarms for the object.</td>
</tr>
</tbody>
</table>

## Configuring the Faceplate

Configuration is done using the *Config view*. Only the user having the privileges of an *Application Engineer* is allowed to configure faceplates.

Note that if the faceplate is Inherited, changes can be made only in the object type.

<table>
<thead>
<tr>
<th>Aspects of 'SP11 Sample'</th>
<th>Modified</th>
<th>Desc...</th>
<th>Inherited</th>
<th>Category name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm and Event List</td>
<td>2000-11-05 10:5...</td>
<td>Alert...</td>
<td>True</td>
<td>Alarm and Event List</td>
</tr>
<tr>
<td>Circulation Pump Sample Type</td>
<td>2000-11-05 11:1...</td>
<td>Circul...</td>
<td>False</td>
<td>Circulation Pump S...</td>
</tr>
<tr>
<td>Faceplate</td>
<td>2000-11-05 14:3...</td>
<td>Face...</td>
<td>True</td>
<td>Faceplate</td>
</tr>
<tr>
<td>Functional Structure</td>
<td>2000-11-20 14:0...</td>
<td>The...</td>
<td>False</td>
<td>Functional Structure</td>
</tr>
</tbody>
</table>
Figure 13. Open Config View

The *Config view* contains the following:

- Layout Configuration of the faceplate geometry.
- Header Configuration of the object lock control and alarm control.
- Indicators Configuration of the Status and Navigation bar.
- Buttons Configuration of the Button area.
- Element Configuration of the faceplate element area.
- Online Help Configuration of the help files.
- Approval or unapproval of faceplates.
Layout Tab

**Layout** tab contains information on the runtime view that should be displayed and the geometrical layout of the views. The faceplate view is mandatory.

Enable/disable of faceplate views requires a restart of the workplace and Operator Workplace.

![Figure 14. Layout Tab with Default Values](image)

Faceplate view is the default runtime view that is launched when an operator clicks on a graphic element in a graphic display. Once the faceplate is opened this can be changed using the **View selection** buttons.

User can also select the orientation of the faceplate element area.

The default size of the faceplate element aspects are designed using preconfigured values of the faceplate width and height.

**Figure 14** shows the configurable parameters in the **Layout** tab.

The update rate for subscribed properties for indicators and buttons are initially set to 1 second. User can configure a new value (in milliseconds) in **Update Rate**.
Header Tab

The settings for Lock button and the Alarm button is configured in the Header tab. These configuration settings are also performance related in case of a search required for finding the Alarm Control or Lock Control aspects.

Figure 15. Header Tab
Object Lock Button

The following settings are done in the Lock button policy area:

- **Default search order**: Uses the following search order.
  - Override Standard LockControl
  - Legacy lock handling
  - Standard LockControl
  - No Lock button

  This search order is executed sequentially. For example, first the LockControl aspect present on the invocation object is used if it exists. Otherwise, the LOCK property on the invocation object is used if exists, and so on. The **Default search order appears by default in the**

- **Override Standard LockControl**: Uses the LockControl aspect present on invocation object, if it exists.

  Select **Prefer PG2 version of LockControl** to use the PG2 lock control aspect if it exists on the object. This is used only if the object includes both VBPG and PG2 faceplates.

- **Legacy lock handling**: Used if the LOCK property exists on the invocation object.

- **Standard LockControl**: Uses the LockControl aspect in the Graphics Structure, below Graphic Tools VB6-> Special.

- **No Lock button**: No lock button is used.

Alarm Control Button

The following settings are available in the Alarm button policy area:

- **Default search order**: Uses the following search order.
  - Override Standard AlarmControl
  - No Alarm button
This search order is executed sequentially. For example, first the AlarmControl aspect present on the invocation object is used if it exists. Otherwise, the no alarm button is used.

- **Override standard AlarmControl**: Uses the AlarmControl aspect present on the invocation object, if it exists.

  Select **Prefer PG2 version of AlarmControl** to use the PG2 alarm control aspect if it exists on the object. This is used only if the object includes both VBPG and PG2 faceplates.

- **No alarm button**: No alarm button is used.

- **Standard AlarmControl**: Uses the AlarmControl aspect in the Graphics Structure, below Graphic Tools -> Special.

**Indicators Tab**

The **Indicators** tab is used to configure the indicators and aspect links to be displayed in the status and navigation area of the faceplate. The user decides the position to display them, depending on the selected view.
Configuring Indicators

Table 3 displays the configurable parameters in the Indicators tab that affect the Status and Navigation area in the faceplate.

Table 3. Indicators

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icons/Labels</td>
<td>The list of Icons/Labels that represent the result of object properties that are subscribed and specified as expressions.</td>
</tr>
<tr>
<td>Expression</td>
<td>A calculation returning an integer value.</td>
</tr>
<tr>
<td></td>
<td>The result must be in the range from 0 to number of Icon/Labels configured - 1.</td>
</tr>
</tbody>
</table>
Table 3. Indicators (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reduced pos</td>
<td>Specifies the position of the indicator in the Reduced view. Position starts from 1 and is counted from left to right with increasing numbers. 0 = Not used by this view. The exact position of the indicator depends on No. of indicators per row, and No. of indicator rows.</td>
</tr>
<tr>
<td>Faceplate pos</td>
<td>The position within the faceplate view.</td>
</tr>
<tr>
<td>Extended pos</td>
<td>The position within the extended view.</td>
</tr>
</tbody>
</table>

Click **Icons/Labels** field, and the **Labels** dialog box appears (refer Figure 17). Add the number of icons or labels to be used for each indicator. The values in **Index** is numbered as 0, 1, 2 to N-1.

Click the column at the extreme left to select an entire indicator row. The user can delete the selected row or order the rows using the spin buttons.

![Figure 17. Configuration of Icons/Labels](image)

Table 3. Indicators (Continued)
Indicators are positioned to the left in the **Status** and **Navigation** area.

For example, to configure the first icon/label to be displayed if the value of a property *LIMIT* is below 50, and the second icon/label to be displayed if the value of the same property is above 50, set the expression for the indicator as:

\[
\text{iif}(.:Control Connection:.LIMIT' < 50, 0, 1)
\]

**Figure 18** displays an indicator if the expression for the indicator is wrongly set, or the expression or expression value causes an error condition.

![Faceplate with Indicator during an Error Condition](image)

**Configuring Aspect Links**

**Table 4** displays the configurable parameters for the aspect links. Aspect links are positioned to the right in the **Status** and **Navigation** area. An aspect link is a button used as a shortcut to call up any type of aspect as an overlap window.

**Table 4. Aspect Links**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>The object of the aspect to be displayed.</td>
</tr>
<tr>
<td>Aspect</td>
<td>The aspect to be displayed as an overlap window.</td>
</tr>
<tr>
<td>View</td>
<td>View for the selected aspect. If a view is selected, the link cannot have a verb.</td>
</tr>
<tr>
<td>AspectVerb</td>
<td>Verb connected to the aspect. If a verb is selected the link can have no view.</td>
</tr>
<tr>
<td>Icon/Label</td>
<td>Label, icon or aspect icon to be displayed on the aspect link.</td>
</tr>
<tr>
<td>Label color</td>
<td>The text color used for the label.</td>
</tr>
</tbody>
</table>
Select Object Dialog window appears on clicking the Object column. Select the required object from this screen and click OK. If the faceplate is configured in the Object Type Structure, user should select only the objects belonging to the same object type.

Click Icon/Label column, the Add Label or Icon screen appears. Select Use aspect icon to get the aspect icon as a graphical representation of the button, or select an icon or specify a label to be displayed.

Refer to IndustrialIT 800xA, Operations, Operator Workplace Configuration (3BSE030322*) for more information on Global Verbs.

Table 4. Aspect Links (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reduced pos</td>
<td>The position within the Reduced view. Refer Table 3 for more information.</td>
</tr>
<tr>
<td>Faceplate pos</td>
<td>The position within the faceplate view.</td>
</tr>
<tr>
<td>Extended pos</td>
<td>The position within the extended view.</td>
</tr>
<tr>
<td>FontSize</td>
<td>The size of the text.</td>
</tr>
</tbody>
</table>
Buttons Tab

The *Buttons* tab allows the user to configure the buttons to be used in the Buttons area of the faceplate. The behavior of the buttons is specified by the **Action** column and the default value is *SystemDefault*.

*Figure 19. Buttons Tab*

*Table 5* displays the configurable parameters for the Button area.
Table 5. Buttons

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>The object of the property to be used, for example, binary.</td>
</tr>
<tr>
<td>Icon/Labels</td>
<td>Label or icon to be used as caption for example, (stop.icon)</td>
</tr>
<tr>
<td>Property name</td>
<td>The object property to which the value should be written when the button is clicked, for example, Value - Binary PCA</td>
</tr>
<tr>
<td>Property type</td>
<td>The data type of the selected object property (ReadOnly). This field gets populated depending on the Property Name selected.</td>
</tr>
<tr>
<td>Property value</td>
<td>The value to be written to the property while clicking the button, for example, True.</td>
</tr>
<tr>
<td>Enabled</td>
<td>An expression specifying whether the button is enabled, dimmed or invisible. No expression means that the button is always enabled. [0 = dimmed, 1 = enabled, 2 = invisible].</td>
</tr>
<tr>
<td></td>
<td>For example, iif(&quot;$/LOCK:Value&quot; = 3, if(&quot;$/Binary:Value:Value,True,False),False)</td>
</tr>
<tr>
<td>Tooltip text</td>
<td>Tooltip to be displayed for the button.</td>
</tr>
<tr>
<td>Reduced pos</td>
<td>The position within the Reduced view. Refer to Table 3 for more information.</td>
</tr>
<tr>
<td>Faceplate pos</td>
<td>The position within the faceplate view.</td>
</tr>
<tr>
<td>Extended pos</td>
<td>The position within the extended view.</td>
</tr>
<tr>
<td>Action</td>
<td>Sets direct or applied action for the button.</td>
</tr>
</tbody>
</table>

More than one button can have the same position. In this case, only one of the overlapping buttons should be visible (that is, only one button can have the expression value of 1 or 0).

Select **Reduced**, **Faceplate**, or **Extended** in **Apply present**, to activate the Apply button for the different views.
The **Apply** button is always located to the right of the button area and cannot be repositioned.

**Elements Tab**

The elements tab is used to configure the faceplate element area. Aspects can be put directly, or can be organized in tab groups.

![Elements Tab](image)

*Figure 20. Elements Tab*

Faceplate Element aspects are designed to be used here, but any aspect type can be used. A faceplate element aspect has a default size to fit within the faceplate view.

Click the **Aspect** column to select the aspect to be represented as a tab in the faceplate.
Select a view to be displayed, in the **View** column.

Type an identifying string representing the identity of a tab group in the **Tab Group** column. A simple number is suitable because the identification string is not visible to any operator.

For example, enter “1” for the first tab group, enter “2” for the second and so on. The location of the tabs in a group is defined by the order among them and can be ordered using the spin buttons.
The following window appears on clicking the Caption column. Type name for the tabs and click OK.
Figure 24. The Caption Dialog Box

**User Roles** column defines the user group having the privilege to access the tab. Only the users belonging to the defined group can view the tab.

Figure 25. Defining of User Role for Faceplate Tabs
The Online Help tab defines the help text to be displayed on pressing the F1 key from the faceplate.

### Table 6. The Elements Tab Columns

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>The object of the aspect to be used.</td>
</tr>
<tr>
<td>Aspect</td>
<td>The faceplate element aspect (or other aspect) placed in the faceplate element area.</td>
</tr>
<tr>
<td>View</td>
<td>Aspect view for the selected aspect.</td>
</tr>
<tr>
<td>Tab group</td>
<td>The tab group identity as a string, for example, as a numeric value 0,1, and so on. The group identity is not shown anywhere.</td>
</tr>
<tr>
<td>Caption</td>
<td>Name of the tab.</td>
</tr>
<tr>
<td>User Roles</td>
<td>User group having access rights for the tab.</td>
</tr>
</tbody>
</table>
Section 3  Alarm and Event Handling

PLC Connect Specific Alarm and Event Lists

PLC Connect supplies three basic types of alarm and event lists. These lists are filtered lists configured to show a selection of the alarms and events:

- PLC Alarm list
- List of Control Blocked Signals
- List of Forced Signals

For more information on alarm and event handling, refer to the *Industrial IT 800xA - System Extended Operation (3BSE036904*)*.

PLC Alarm List

This list shows alarms, including alarms disabled by an operator. *Figure 26* shows an example.

<table>
<thead>
<tr>
<th>Ack Severity</th>
<th>Event Time</th>
<th>Object Name</th>
<th>Condition</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>12-17 11:51:10.191 sign</td>
<td>Binary type</td>
<td>Acknowledged -</td>
<td></td>
</tr>
<tr>
<td>1000</td>
<td>12-16 12:32:01.845 sign</td>
<td>long:Limiter2</td>
<td>Acknowledged -</td>
<td></td>
</tr>
</tbody>
</table>

*Figure 26. PLC Alarm List*

The columns are:

- **Ack**: Shows whether the alarm is acknowledged or not. You can also acknowledge an alarm in this column.
- **Pri**: The priority of the alarm.
- **Event Time**: Time when the alarm was generated. If the alarm is disabled, this column shows the time when the alarm was disabled.
- **Object Name**: The name of the process object and signal.
List of Control Blocked Signals

This list shows control blocked signals, see Figure 27 for an example. These are manually controllable signals that are disabled. The values of a control blocked signal can’t be changed by an operator.

<table>
<thead>
<tr>
<th>Event Time</th>
<th>Object Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>10/30 08:13:00</td>
<td>A1aObject2-A5</td>
</tr>
<tr>
<td>10/30 08:08:14</td>
<td>A1aObject2-A1</td>
</tr>
<tr>
<td>10/30 08:08:14</td>
<td>A1aObject2-A3</td>
</tr>
<tr>
<td>10/30 08:07:51</td>
<td>A1aObject1-A2</td>
</tr>
<tr>
<td>10/30 08:07:47</td>
<td>A1aObject1-A1</td>
</tr>
</tbody>
</table>

Figure 27. List of Control Blocked Signals

The columns are:

- **Event Time.** Time when the control signal was disabled.
- **Object Name.** The name of the process object and signal.

List of Forced Signals

This list shows forced signals, see Figure 28 for an example. Forced signals are signals whose values are temporarily forced to a certain value, that is, the signal values appear to be constant regardless of the actual process values.

The columns are:

- **Event Time.** Time when the signal was forced.
- **Object Name.** The name of the process object and signal.
Current Value. The value that the signal is forced to.

**Using the Lists**

To enable a disabled alarm, enable a control signal, or remove the forcing of a signal value:

1. Right-click the signal row.
2. Select **Enable selected** or **Enable object** from the context menu.

*Figure 28. List of Forced Signals*
Section 4  Dialed Communication

License information: The dial manager is part of the PLC Connect Dialed communication functionality which requires a separate license to run.

Introduction

This section describes dialed communication:

• **Dial Panel** on page 50 is used to control the communication with a single remote controller.

• **Dial Supervisor** on page 52 is used to supervise and control the communication in a whole control network.

What is Dialed Communication?

Remote controllers can be dialed up and communicated with via Comli or Modbus (Serial), that is, live process data and historic information can be collected to a server. For Comli, time marked events can be collected too. Provided are:

• Manually order calls, with and without a time limit.

• Permanent calls.

• Scheduled (cyclic) calls for collection of historic data.

Incoming connections are also supported, where controllers can call up the server in the case of an alarm and so on.
Dial Panel

The Dial Panel aspect, see Figure 29, contains the basic functions to initiate, monitor and terminate calls to a remote controller.

To access the aspect:
1. Start a Workplace.
2. Select the Control Structure.
3. Select the dialed controller.
4. Select the Dial Panel aspect. Use it to initiate, monitor and terminate calls.
5. If desired, repeat Step 3 to Step 4 for each other dialed controller.

There can be aspect links to a Dial Panel aspect in process graphic displays. If present, you can also click such a link to access the aspect.

Select the Type of Call

Select the type of call by clicking either:

- Time Limit [minutes]. Enter the time limit in minutes in the text box to the right.

Manual Close

Select this type of call to keep the connection open until the call is manually terminated. If an error occurs whereby the connection is terminated, it will remain terminated, that is, the connection will not be automatically re-established.
Time Limit
Select this type of call if the connection is to be terminated automatically after a certain amount of time. The call can also be manually disconnected at any time.

Initiate/Terminate a Call
The button in the Dial Panel will be labeled **Dial** when no connection is established, and **Hang up** when a connection is established:

- When you have selected the type of call, click **Dial** to initiate the call.
- Click **Hang up** to terminate the call.

View Call Status
A status indication shows the basic status of a manual call, see Table 7, while the bottom line of the Dial Panel displays status information for both types of calls, for example, initiating, connected, disconnecting, disconnected, and so on.

*Table 7. Call Status Indication*

<table>
<thead>
<tr>
<th>Appearance</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Dimmed" /></td>
<td>The indication is <em>dimmed</em> when no connection is established.</td>
</tr>
<tr>
<td><img src="image" alt="Red" /></td>
<td>The indication is <em>red</em> when a connection has failed.</td>
</tr>
<tr>
<td><img src="image" alt="Yellow" /></td>
<td>The indication is <em>yellow</em> when a call is in progress.</td>
</tr>
<tr>
<td><img src="image" alt="Green" /></td>
<td>The indication is <em>green</em> when a connection to a controller is established.</td>
</tr>
</tbody>
</table>
Dial Supervisor

The Dial Supervisor aspect, see Figure 30, contains functions to initiate, monitor (supervise) and terminate calls to remote controllers in a specific control network.

![Figure 30. Dial Supervisor Aspect](image)

To access the aspect:

1. Start a Workplace.
2. Select the Control Structure.
3. Select the desired Generic Control Network object.
4. Select the Dial Supervisor aspect. Use it to initiate, monitor and terminate calls.
5. If desired, repeat Step 3 to Step 4 for each other control network.

💡 There can be aspect links to a Dial Supervisor aspect in process graphic displays. If present, you can also click such a link to access the aspect.

Specify a Call

Call to a Specific Controller

Under the Initiate Calls tab, see Figure 30, select a controller from the Controller drop-down list, and then select the type of call by clicking either:
- **Manual Close.** Select this type of call to keep the connection open until the call is manually terminated. If an error occurs whereby the connection is terminated, it will remain terminated, that is, the connection will not be automatically re-established.

- **Permanent.** Select this type of call to keep the connection open permanently. If an error occurs whereby the connection is terminated, attempts will automatically be made to re-establish the connection. These attempts will continue until the connection can be re-established.

- **Time limit.** Select this type of call if the connection is to be terminated automatically after a certain amount of time. The call can also be manually disconnected at any time. Enter the time limit in minutes in the text box to the right.

- **History: Single controller.** Select this type of call to collect historic data from a single controller. The option to keep text files after import is used for troubleshooting purposes only.

**Cyclic Call**

Cyclic calls are used to automatically collect historic data from a number of controllers at scheduled times. For example, at 3 PM the historic data can be scheduled to be collected from controllers A and B, while at 5 PM it can be scheduled to be collected from controllers C and D. Sometimes this collection can’t be done due to errors, for example, if one or more of the controllers scheduled to be called at a certain time are down at the call time. If such an error occurs, you can manually initiate a cyclic call.

In the Collect History Data area, select a scheduled call time from the drop-down list. All controllers scheduled to be called at the selected time will be called when the call is initiated.

The option to keep text files after import is used for troubleshooting purposes only.

**Initiate a Call**

When you have specified a call, click the relevant **Dial** button under the Initiate calls tab.
**Terminate/Disable a Call**

Under the Initiate Calls tab, the Call Status area shows call status information when there is an active call to the controller selected from the Controller drop-down list. To terminate that active call, click **Hang up** in the Type of call area.

Under the Line Status tab, see Figure 31, a table with information on each active call is shown. Select a connection by selecting its name in the Line column, and:

- Click **Hang up Cyclic** to terminate a cyclic call, that is, a call for which the Call Type column contains the word cyclic.
- Click **Hang up** to terminate a normal call.
- Click **Disable Line** to disable the line, that is, to avoid using the line for outgoing calls, for example, when a line behaves badly. Lines can also be disabled by the system.
- Click **Enable Line** to enable a disabled line.

**Figure 31. Line Status Tab**

**View Call Status**

Under the Initiate calls tab, the Call Status area shows call status information when there is an active call to the controller selected from the Controller drop-down list.
The Time connected box shows the time the call has been active in hours, minutes and seconds, while the Time remaining box shows the time remaining until the call is terminated.

The table to the right shows how the call is proceeding.

Under the Line status tab a table with information on each active call is shown.
INDEX

A
Abort Call 50 to 55
Acknowledge 45
Alarm 47, 49
   Acknowledge 45
   List 45
Aspect Link 50, 52
   configure 36

C
Call
   Abort 50 to 55
   Collect History 53
   Cyclic 49, 53 to 54
   Disable 54
   Initiate 50 to 53
   Manual 49 to 50, 53
   Monitor 50 to 52, 54
   Permanent 49, 53
   Scheduled 49, 53 to 54
   Specify 50, 52
   Status 50 to 52, 54
   Terminate 51
   Time Limit 49 to 51, 53
   Type 50, 52
Collect History 49, 53
Configuration of Label/Icons 35
Connection 49
Connectivity 9
Control
   Blocked Signals 45 to 46
   Process 11
   Signal 47

D
Control Network 49, 52
Controller 49, 52
Cyclic Call 49, 53 to 54

E
Dial Panel 50
Dial Supervisor 52
Disable
   Alarm 47
   Call 54
   Control Signals List 45 to 46
   Line 54
Disconnect Call 50 to 55

Enable 47
   Alarm 47
   Line 54
Event
   List 45

F
Faceplate
   configure 28
Faceplate framework configuration
   buttons tab 38
   elements tab 40
Force
   Remove 47
   Signal List 45 to 46

G
Graphics 11
Index

See also Process Graphics

H
- History 49, 53

I
- Incoming Connection 49
- Indicators tab 33
- Industrial IT 800xA 9
- Initiate Call 50 to 53

L
- Label/Icons dialog 35
- Layout tab 30
- Line
  - Disable 54
  - Enable 54
- List
  - Alarm and Event 45
  - Control Blocked Signals 45 to 46
  - Forced Signals 45 to 46

M
- Manual
  - Call 49 to 50, 53
  - Controllable Signals List 45 to 46
  - Monitor Call 50 to 52, 54

O
- Object
  - See also Process Object
  - Object Lock 26
    - push button 26

P
- Permanent Call 49, 53
- PLC 9
- PLC Alarm List 45
- PLC Connect 9

Process 11
- Status 11
- Process Graphics 11
  - Aspect Link 50
  - Display 50, 52

R
- Remote Controller 49
- RTU 9

S
- Scheduled Call 49, 53 to 54
- Signal 47
  - See also Process Signal
- Status
  - Call 50 to 52, 54
  - Process 11

T
- Terminate Call 50 to 55
- Text File 53
- Time Limited Call 49 to 51, 53
- Type of Call 50, 52

W
- Warning
  - Level 11
  - Status 11
Contact us

ABB AB
Control Systems
Västerås, Sweden
Phone: +46 (0) 21 32 50 00
Fax: +46 (0) 21 13 78 45
E-Mail: processautomation@se.abb.com
www.abb.com/controlsystems

ABB Inc.
Control Systems
Wickliffe, Ohio, USA
Phone: +1 440 585 8500
Fax: +1 440 585 8756
E-Mail: industrialitsolutions@us.abb.com
www.abb.com/controlsystems

ABB Industry Pte Ltd
Control Systems
Singapore
Phone: +65 6776 5711
Fax: +65 6778 0222
E-Mail: processautomation@sg.abb.com
www.abb.com/controlsystems

ABB Automation GmbH
Control Systems
Mannheim, Germany
Phone: +49 1805 26 67 76
Fax: +49 1805 77 63 29
E-Mail: marketing.control-products@de.abb.com